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Legal Notices
This product is subject to the terms and conditions of a software license agreement.

This user manual is copyrighted © 2016 by WaveDNA Ltd., (hereafter “WaveDNA”), with all rights 
reserved. Under copyright laws, this user manual may not be duplicated in whole or in part without the 
written consent of WaveDNA.

Product features, specifications, system requirements and availability are subject to change without 
notice.

Document Feedback
We are constantly looking for ways to improve our documentation. Please email any comments, 
corrections or suggestions to info@wavedna.com. Your feedback is very much appreciated.
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3LIQUID MUSIC

Welcome to Liquid Music ...............................................................................................8

1.1  Message from WaveDNA .....................................................................................................8
1.2  Minimum Requirements .......................................................................................................8

1.2.1  Mac OS ................................................................................................................................8
1.2.2  Windows ...............................................................................................................................8

1.3  Installation ............................................................................................................................9
1.3.1  OS X Instructions .................................................................................................................9
1.3.2  Windows Instructions .........................................................................................................12

1.4  Registration ........................................................................................................................16
1.4.1  For Existing Users ..............................................................................................................16
1.4.2  For New Users ...................................................................................................................17

Quickstart Guide ...................................................................................................................19

2.1  Load a Preset  ....................................................................................................................19
2.2  Draw a Sketch ....................................................................................................................20
2.3  Editing Notes ......................................................................................................................21

2.4  Customizing Settings .........................................................................................................22

Orientation and Setup .....................................................................................................23

3.1  Nomenclature .....................................................................................................................23
3.1.1  OS X & Windows Keyboard Commands Terminology .......................................................23
3.1.2  Mouse Terminology ............................................................................................................23
3.1.3  Music Terminology .............................................................................................................24

3.2  Welcome Screen ................................................................................................................25
3.3  Settings ..............................................................................................................................26

3.3.1  Look and Feel ....................................................................................................................26
3.3.2  Library ................................................................................................................................26
3.3.3   Diagnostics ........................................................................................................................26
3.3.4  Harmony .............................................................................................................................27
3.3.5  Clip Mode ...........................................................................................................................27
3.3.6  Devices ..............................................................................................................................27

3.4   How to connect a MIDI Device to your computer ..............................................................28
3.4.1  Testing Your External MIDI Controller ................................................................................28



4LIQUID MUSIC

DAW Integration and Setup .......................................................................................29

4.1   Ableton Live 9 ....................................................................................................................30
4.1.1  Max for Live Patch in Live ..................................................................................................30
4.1.2  VST / AU Mode ...................................................................................................................32

4.2   Logic Pro X .........................................................................................................................34
4.2.1  Audio Unit Mode ................................................................................................................34

4.3  Bitwig .................................................................................................................................36
4.3.1  VST Mode ...........................................................................................................................36

4.4  Cubase ...............................................................................................................................38
4.4.1  VST mode ...........................................................................................................................38

4.5  Pro Tools ............................................................................................................................40
4.5.1  AAX Plug-in Mode ..............................................................................................................40

4.6  Studio One 3 ......................................................................................................................42
4.6.1  VST Mode ...........................................................................................................................42
Multiple Plug-In Instances for Liquid Music ..........................................................................................44

User Interface Elements ................................................................................................45

5.1  Toolbar ...............................................................................................................................45
5.1.1  Clip Controls ......................................................................................................................45
5.1.2  Follow Playhead .................................................................................................................46
5.1.3  Loop Controls .....................................................................................................................46
5.1.4  Refresh from Live ...............................................................................................................46
5.1.5  Edit MIDI Map ....................................................................................................................47
5.1.6  Panel Show / Hide Buttons .................................................................................................47

5.2  Harmony Builder ................................................................................................................48
5.2  Arranger .............................................................................................................................49

5.2.1  Arranger Canvas ................................................................................................................50
5.2.2  Contour Edit .......................................................................................................................50
5.2.3  Piano Roll ...........................................................................................................................51
5.2.4  Rhythm Edit ........................................................................................................................51
5.2.5  Rhythm Track (see also page 93) ......................................................................................52
5.2.6  Chord Track (see also page 64) ........................................................................................52



5LIQUID MUSIC

Master Presets .........................................................................................................................53

6.1  Load a Preset .....................................................................................................................53
6.2  Randomize Presets ............................................................................................................54

6.2.1  Mixing-and-Matching .........................................................................................................54
6.2.2  Scramble! ...........................................................................................................................55
6.2.3  Options ...............................................................................................................................55

6.3  Preset Filters ......................................................................................................................56

6.4  Transpose ..........................................................................................................................57

Sketch  .............................................................................................................................................58

7.1  How to Draw Notes ............................................................................................................58
7.1.1  Fundamental Concepts ......................................................................................................58
7.1.2  Interacting with your Sketch ...............................................................................................59

7.2  Layer Presets .....................................................................................................................59
7.3  Settings ..............................................................................................................................60

7.4  Sketching Tips ...................................................................................................................61

Chords .............................................................................................................................................62

8.1  Preface ...............................................................................................................................62
8.2  Chords Layer Presets ........................................................................................................63
8.3  Chord Overview .................................................................................................................64

8.3.1  Chord Track .......................................................................................................................64
8.3.2  Add a chord .......................................................................................................................65
8.3.3  Select a chord ....................................................................................................................66
8.3.4  Resize Chords ....................................................................................................................67
8.3.5  Loop Chords ......................................................................................................................67
8.3.6  Chord Overview Options ....................................................................................................68

8.4  Suggester ...........................................................................................................................69
8.4.1  How to use the Suggester ..................................................................................................70
8.4.2  Scramble the Suggester ....................................................................................................71

8.5  Sequencer ..........................................................................................................................72
8.5.1  Chord Roots .......................................................................................................................73
8.5.2  Out-of-Key Root Notes .......................................................................................................73
8.5.3  Chord Types ......................................................................................................................74
8.5.4  Out-of-Key Chord Types ....................................................................................................75
8.5.5  Chord Modifiers .................................................................................................................76



6LIQUID MUSIC

Voices ...............................................................................................................................................77

9.1  Voice Layer Presets ...........................................................................................................77
9.2  Voice Control ......................................................................................................................78

9.2.1  Presets ...............................................................................................................................78
9.2.2  Voice ..................................................................................................................................79
9.2.3  Nudge Voices ....................................................................................................................79
9.2.4  Motion ................................................................................................................................80
9.2.5  Frequency / Offset / Pattern Reset .....................................................................................81
9.2.6  Probability ..........................................................................................................................82
9.2.7  Re-Apply Settings ..............................................................................................................83
9.2.8  Scramble! ...........................................................................................................................83
9.2.9  Voice Control Options ........................................................................................................84
9.2.10  Voice Filter and Arpeggiator Active Indicators ..................................................................84

9.3  Arpeggiator ........................................................................................................................85
9.3.1  Turn on the Arpeggiator .....................................................................................................85
9.3.2  Arpeggiator Styles .............................................................................................................86
9.3.3  Reset the Arpeggiator ........................................................................................................86
9.3.4  Offset / Pattern Reset .........................................................................................................86
9.3.5  Re-Apply ............................................................................................................................87
9.3.6  Scramble! ...........................................................................................................................87
9.3.7  Arpeggiator Options ..........................................................................................................88

9.4  Voice Filter .........................................................................................................................89
9.4.1  Voice Filter Presets ............................................................................................................89
9.4.2  Polyphony Buttons .............................................................................................................90
9.4.3  Polyphony Sliders ..............................................................................................................91
9.4.4  Voice Filter Re-Apply .........................................................................................................91

Rhythm ............................................................................................................................................92

10.1  Rhythm Layer Presets ........................................................................................................92
10.1.1  Rhythms in Liquid Music ....................................................................................................93
10.1.2  Rhythm Edit ........................................................................................................................93

10.2  Duration Modifiers ..............................................................................................................94
10.2.1  Presets ...............................................................................................................................94
10.2.2  Duration Modifier Buttons ..................................................................................................95
10.2.3  Duration Modifiers Sliders ..................................................................................................96
10.2.4  Re-Apply ............................................................................................................................96
10.2.5  Duration Scramble! ............................................................................................................97
10.2.6  Duration Options ................................................................................................................97

10.3  Velocity Modifiers ...............................................................................................................98



7LIQUID MUSIC

10.3.1  Velocity Modifiers Presets ..................................................................................................99
10.3.2  Velocity Modifier Buttons ...................................................................................................99
10.3.3  Velocity Modifier Sliders ...................................................................................................100
10.3.4  Velocity Modifiers Re-Apply .............................................................................................101
10.3.5  Velocity Modifiers Scramble! ...........................................................................................101
10.3.6  Velocity Modifiers Options ...............................................................................................102

10.4  Groove Modifiers ..............................................................................................................103
10.4.1  Groove Presets ................................................................................................................104
10.4.2  Groove Modifier Sliders ...................................................................................................105
10.4.3  Groove Modifiers Re-Apply ..............................................................................................105
10.4.4  Groove Modifiers Scramble! ............................................................................................106
10.4.5  Groove Modifiers Options ................................................................................................106

Key .....................................................................................................................................................107

11.1  Key Layer Presets ............................................................................................................107
11.2  Key Selector .....................................................................................................................108

11.2.1  Key ...................................................................................................................................108
11.2.2  Mode ................................................................................................................................108
11.2.3  Dual  .................................................................................................................................109
11.2.4  Key Options .....................................................................................................................109

Glossary .......................................................................................................................................110



8Welcome

Chapter 1

Welcome to Liquid Music

1.1  Message from WaveDNA

On behalf of everyone at WaveDNA: Thank you for supporting our software and welcome to 
Liquid Music! We at WaveDNA are a motley crew of musicians, programmers, designers, 
and genuine fans of music. For the last year, we’ve been designing something we hope 
will inspire your creativity and have you producing music you might never have imagined. 
This guide is designed to get you started quickly, but you’ll also find in depth explanations 
of the various features found in Liquid Music here. We encourage you to use the table 
of contents liberally and jump to the sections that will help you immediately.

Enjoy Liquid Music =)

1.2  Minimum Requirements

1.2.1  Mac OS

* Intel i3 processor
* 2 GB ram (recommended 4 GB) 
* 6 GB hard disk space
* OS X 10.6 or later
* Java v1.6 or later

1.2.2  Windows

* Intel i3 processor
* 2 GB ram (recommended 4 GB)
* 6 GB hard disk space
* Windows Vista (recommended Windows 7 or later)
* Java v1.6 or later



9Welcome

1.3  Installation

1.3.1  OS X Instructions

1. Navigate to the installation .dmg file you 
downloaded and double-click it.

2. Agree with our reasonable 
terms to continue.

 

3. Double-click Install Liquid Music.pkg. 
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4. Follow the steps in the installer. First, 
Select a Destination for the install files.

5. Next, select which Plugin 
Packages you want to install. 
We encourage you to install 
them all if you are not sure 
exactly what youre doing.  

6. Click Install to begin the installation. 
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7. After a few moments, a message 
will appear indicating the 
Installation was successful. 
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1.3.2  Windows Instructions

1. If you already have Liquid Rhythm installed, go to Add or 
remove programs and uninstall Liquid Rhythm.

2. Navigate to the installation .exe file you downloaded 
and double-click it. Never mind that it’s labeled 
“Liquid Rhythm”; you are installing both.

3. Select a language to run the 
installer in and click OK.

4. A setup window will appear and 
guide you through the install.  
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5. Accept our reasonable terms to continue.

6. Select a Destination Location for the 
install. The default directory path is 
in the dialogue box. We recommend 
that you do not alter this path.

7. Select which Components (plugins) 
to install. Note that in order to run 
Liquid Music, you must install the Max 
for Live Plugin. At this time, the VST 
plugins are for Liquid Rhythm only.
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8. Select the Start Menu folder.

9. Select Additional Tasks. In 
this case, select whether or not 
you want a desktop icon.

10. Click Install to continue.
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11. During the install process, you will 
be prompted by the Plugin Setup 
Wizard to install the selected versions 
of the Liquid Rhythm VST. 

12. Choose a Destination Location 
for the VST plugin. 

13. And that’s it!
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1.4  Registration

1.4.1  For Existing Users

To register your copy of Liquid Music:

1. Launch Liquid Music.

2. Run Liquid Music and go to Help 
> Input Activation License...

3. Input your email address and the 
confirmation key we sent you into 
the Register Retail Key window that 
appears. Click the Submit button 
to complete your registration. 
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1.4.2  For New Users

To register your copy of Liquid Music:

1. Launch Liquid Music for Live.

2. You will be greeted by our 
Terms and Conditions. Please 
accept them to continue. 

3. Select Input Activation Code in 
the window that appears.

4. Enter your email address and the Activation 
Code we sent you. Click the Submit 
button to complete your registration. 
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You are now ready to use Liquid Music! 
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Chapter 2

Quickstart Guide

2.1  Load a Preset 

 

Single-click a Master Preset in this list 
to load some Liquid Music settings.
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2.2  Draw a Sketch

 
Click-and-drag the cursor along 
the Arranger to draw a Sketch.
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2.3  Editing Notes

Notes appear around the yellow sketches 
you draw. To make edits to notes, draw 
a new Sketch or load a new Preset.
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2.4  Customizing Settings

In Liquid Music, you don’t click-
and-grab MIDI notes to edit them. 
Instead, use the customizing 
controls found within these Tabs. 
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Chapter 3

Orientation and Setup

3.1  Nomenclature

The purpose of this guide is to show you how to use every available feature in Liquid Music. Depending 
on your experience with audio software, some of the language used to describe those features 
might be unknown. To get the most out of the instructions in the following chapters, please read this 
chapter. It outlines common lingo and terminology you will find throughout the rest of this book.

3.1.1  OS X & Windows Keyboard Commands Terminology

In the Liquid Music User Manual, keyboard shortcuts will be presented 
using a combination of modifier keys and keyboard keys. 

For your reference and convenience, modifier keys will always be presented in the order of [OS 
X]/ [Win] where OS X refers to Apple keyboards and Win refers to Windows keyboards.

Note that Apple and Windows keyboards have different names for modifier keys that serve the 
same function in Liquid Music. All this means is, for example, to copy something in OS X you use 
the [command]+[C] keyboard shortcut, the same copy command on Windows can be achieved 
using the [ctrl]+[C] keyboard shortcut. This example would appear in this manual as [command]/
[ctrl]+[C]. Similarly functioning modifier keys have been paired accordingly. Modifier Keys are:

* [command]/[ctrl]
* [option]/[alt]
* [shift]
* [control] **OS X only**

3.1.2  Mouse Terminology

* Click: single-click with the left mouse button.
* Double-click: double-click (in rapid succession) with the left mouse button.
* Right-Click: single-click with the right mouse button. Right-clicks typically 

open pop-up or pull-down menus for that specific clickable object.
* Drag: to click on an object and hold down the mouse button while moving the 

mouse. To stop the drag from occurring, release the mouse button.
* Drag-and-Drop: to click on an object it, hold the button down while moving 

the mouse, and releasing the mouse button to complete the action.
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3.1.3  Music Terminology

* Note: A unique pitch / frequency. In this manual, you will find 
the terms note and pitch to be used interchangably. 

* Chord: A harmonic grouping of pitches; see page 110 for more information. 
* Scale: A set of pitches; see page 113 for more information. 
* Rhythm: A distinct and repetitious pattern heard / played / 

felt in time; see page 113 for more information. 
* Sharps and flats: Throughout the book, references to sharps 

will appear as # and flat will appear as b
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3.2  Welcome Screen

A Welcome Screen greets you when you launch Liquid Music. When you’re new to any software, 
tools like this provide useful tips and guides; when you’re more familiar with the software, you might 
want to hide this screen. That’s ok! This window has no feelings, and we totally understand. 

* Read Liquid Music Quickstart Guide: Read a brief and informative 
document featuring some Liquid Music basics.

* Watch Liquid Music Quickstart Video: Watch an informative 
quickstart video featuring Liquid Music basics.

* Read Liquid Rhythm Quickstart Guide: Reference the Liquid Rhythm quickstart PDF. 
* Watch Liquid Rhythm Quickstart Video: Watch an informative 

quickstart video featuring Liqui Rhythm basics.
* Show on Startup: Check / uncheck this to show or hide this window on startup. 
* Close: Make the wecome screen go away. 
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3.3  Settings

The adjustable parameters in the Settings menu are meant to make Liquid Music suit your workflow 
best. Use the options in the Settings window to configure your soundcard, changing the look of a 
specific UI element, or customize the feel of the Harmony panel. Access the Settings window by either:

* In the menubar, go to LiquidHarmony > Preferences ... (OS X)
* Use the [command]/[ctrl]+[,] key command.

3.3.1  Look and Feel

Want to change how Liquid Music looks? No problem. The Look and Feel tab in the 
setting menu gives you control over a variety of options and parameters.

3.3.2  Library

Assign a path to install the Liquid Music library. 

3.3.3   Diagnostics

Turn on diagnostic mode, disable error reports, or activate Alternative 
Playhead Redraw using the options in this menu.
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3.3.4  Harmony

Customize how chords are labeled, what kinds of guidelines appear 
in the arranger, and an assortment of other parameters. 

3.3.5  Clip Mode

A variety of options regarding how the Max for Live plugin behaves. 

3.3.6  Devices

A list of the hardware devices connected to your computer and recognized by Liquid Music. 
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3.4   How to connect a MIDI Device to your computer

There are two ways to connect a MIDI device to your computer:

1. Connecting an external MIDI device directly via USB:
i. Many new MIDI devices connect to your computer with a USB cable and have 

their own drivers. Make sure your MIDI device is connected to your computer 
and recognized by your operating system before launching Liquid Music.

2. Connecting an external MIDI device through a MIDI interface:
i. Once you’ve connected your MIDI interface, make the following physical 

connections between your external MIDI device and MIDI interface:
a. The MIDI Out on your external device is connected 

to the MIDI IN on your MIDI interface.
b. The MIDI IN on your external device is connected to 

the MIDI OUT on your MIDI interface.

Tip: To ensure you have followed all the necessary steps and installed all the necessary 
drivers to enable compatibility between your computer and MIDI interface, please 
reference the MIDI interface manufacturer’s documentation or website.

3.4.1  Testing Your External MIDI Controller

The MIDI Note and Vel indicators to the right of the toolbar will display MIDI values Liquid Music 
receives from an external device. With your MIDI device connected and turned on, press a key on your 
MIDI keyboard, drum pad or control surface to test connectivity and monitor it using the indicators.
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Chapter 4

DAW Integration and Setup
Liquid Music is available to use within a variety of host DAWs as either a VST, AU, 
AAX, or Max for Live plug-in. In this workflow, you can use Liquid Music to send MIDI 
to your own sample tanks, software plug-ins and even physical synthesizers.

Note that in this mode, there is only one Liquid Music window. You will be using 
the Editor button in the accompanying DAW plug-in window to switch between 
multiple instances. For more instructions, please refer to page 44. 

Also, note that the plug-in version of Liquid Music does not have transport controls–like Play, 
Stop, FF, RW–or loop / cycle control. Both the transport controls and looping belong to the 
host DAW; there is no way to dislodge our slaved plug-in from these host functions. 

For your convenience, step-by-step plug-in loading procedures have 
been documented for a variety of DAWs, including:

* Ableton Live 9
i. Max for Live (see page 30)
ii. VST (see page 32)

* Logic Pro X (see page 34)
* Bitwig (see page 36)
* Cubase (see page 38)
* Pro Tools (see page 40)
* Studio One 3 (see page 42)
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4.1   Ableton Live 9

4.1.1  Max for Live Patch in Live

Selecting a MIDI clip in Ableton Live 9 activates Liquid Music using the Max for Live 
bridge. Follow these steps to load the Liquid Music Max for Live patch.  

 

1. Launch Ableton Live 9.

2. Create a MIDI track by either 
selecting Create > Insert MIDI Track 
or using the [command]+[shift]+[T] 
keyboard command. Note that you 
can use an existing MIDI track if 
Ableton loaded one in the default set.

3. In the Live Browser (that panel 
on the left), navigate to Max for 
Live > Max MIDI Effect to locate 
LiquidMusic.amxd. Drag-and-
drop LiquidMusic.amxd onto 
the MIDI track you just created.

LiquidRhythm.amxd
LiquidRhythm.amxd
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4. Load your favorite Ableton or 3rd 
party Software Instrument onto any 
MIDI track. Software Instruments are 
usually in the Instruments or Plug-Ins 
Categories in the Ableton Browser. 

 

To use the rhythm tools, simply load an Ableton Drum Rack instead of a 
melodic or harmonic instrument. When you select a clip on a track with a Drum 
Rack, the interface will change and you’ll be working in the Liquid Rhythm 
environment. Alternatively, use the View > Switch to Rhythm Tools option.

5. Create a clip in the MIDI track containing the 
Software Instrument you just loaded.

6. Select the clip you just created and switch to Liquid Music 
using the [command]\[alt]+[tab] key command.  
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4.1.2  VST / AU Mode

The Liquid Music VST can send MIDI to any other plug-in in Ableton Live. Also, for OS X users, 
you’ll notice that Liquid Music–apart from being an option as an Ableton Track–also appears as 
a physical MIDI device. Think of this as a physical device–such as an MPC or a keyboard–that 
you have connected to your computer. You can set all MIDI tracks to receive Liquid Music’s 
output by setting Virtual MIDI Port to ‘ON’. Since you might not want such a broadly effective 
routing, we have defaulted this setting to ‘OFF’. In fact, if you don’t know how to use what I just 
described to your advantage, I’d strongly recommend proceeding with the instructions below 
and not activating Virtual MIDI Port ever. Who knows.. We might even hide it for future builds!

1. Launch Ableton Live 9.

2. Create a MIDI track by either selecting 
Create > Insert MIDI Track or using 
the [command]+[shift]+[T] keyboard 
command. Note that you can use 
an existing MIDI track if Ableton 
loaded one in the default set.

3. In the Live Browser, select Plug-ins 
> VST or Plug-ins > Audio Units. For 
stability, we recommend the VST plug-in. 
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4. Drag-and-drop the LiquidMusic VST 
or AU onto the MIDI track you created. 
This will result in two things: First, Liquid 
Music will launch. Second: Note the 
Ableton plug-in window that appears.

5. Create a second MIDI track; load 
any software instrument plug-in. 

6. In this MIDI track (aka, the track you want to send 
MIDI to) change the MIDI input from All Ins to the 
Liquid Music track. Note that there will be two Liquid 
Music options available: The ‘Physical Device’ in 
the MIDI inputs list, and the Ableton track itself. 
Select the Track; it will be named X-LiquidMusic 
(where X = the Ableton track number).  

7. In the drop-down menu directly below, select LiquidMusic.

8. You will now have MIDI piped from Liquid Music to the plug-in you wish to control.
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4.2   Logic Pro X

4.2.1  Audio Unit Mode

In Logic Pro X, Liquid Music functions as a MIDI effect. You can load multiple instances 
while maintaining only one application window. Switch between each instance by locating 
the Logic plug-in window for the instance you wish to edit and click the EDITOR button.

1. Launch Logic Pro X

2. Create a new software 
instrument track by selecting 
Track > New Software 
Instrument Track or by 
using the appropriate 
keyboard shortcut. 

3. In the channel strip of the 
resulting software instrument 
track, click the MIDI FX button 
and load Audio Units > 
WaveDNA Ltd. > LiquidMusic
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4. This will result in two things: The Liquid 
Music application will launch, and you will 
also get a Logic Pro X plug-in window.

5. In the channel strip of the same software 
instrument track, click the Instrument 
button and load any software instrument.

6. Now, all the MIDI you draw in Liquid Music gets piped 
into the software instrument you loaded.

7. To switch between multiple instances of Liquid Music, click the EDITOR button in 
the plug-in window. Liquid Music’s arranger will update to display the contents of 
the selected track. For greater detail regarding multiple instances, see page 44.
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4.3  Bitwig

In Bitwig, the Liquid Music VST functions as a MIDI effect you place in the 
signal path of a track you wish to control. On a single track, you need both the 
Liquid Music plug-in and a software instrument to produce sound. 

4.3.1  VST Mode

1. Launch Bitwig.

2. Create an instrument track 
by clicking Create > Create 
Instrument Track

3. In Browser > Devices select VST (System).



37DAW Integration

4. Find LiquidMusic in the Category 
list and drag-and-drop it onto the 
newly created instrument track. 

5. Add a software instrument or sampler 
to the device chain in the same 
track containing LiquidMusic.

6. To switch between multiple instances of Liquid Music, click the EDITOR button in the 
plug-in window. Liquid Music’s arranger will update to display the contents of the 
selected track. For greater detail regarding multiple instances, see page 44.
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4.4  Cubase

Liquid Music works in Cubase by routing MIDI from the VST track to the plug-ins you wish to 
control. You can load multiple instances of the plug-in and switch between them using the 
EDITOR button found on the plug-in window (which is separate from the application window). 
Note that in Cubase, Liquid Music’s ‘physical MIDI device’ is available to use as well. Think 
of this as a physical device that you have connected to your computer; it’s even possible 
to connect the LM-Track-1 from Cubase to another DAW! Funky? We thought so. 

4.4.1  VST mode

1. Launch Cubase.

2. Click Devices > VST Instruments

3. In the VST Instruments window, click 
Rack Instruments > Synth > Liquid 
Music to launch Liquid Music.

4. Next, load any other software instrument. You can 
do this using the VST Instruments window as well. 
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5. In the Inspector, for the software 
instrument track you just selected–the 
one you wish to control with Liquid 
Music–locate the MIDI input drop-down 
menu (it defaults to All MIDI Inputs). 
You will notice two Liquid Music related 
options. Select the output of the actual 
LiquidMusic track you have loaded; it will 
be named X. Liquid Music - MIDI output 
(where X is the Cubase track number).

6. To switch between multiple 
instances of Liquid Music, 
click the EDITOR button in 
the plug-in window. Liquid 
Music’s arranger will update 
to display the contents of the 
selected track. For greater 
detail regarding multiple 
instances, see page 44. 
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4.5  Pro Tools

4.5.1  AAX Plug-in Mode

1. Launch a Pro Tools session and 
open the New Track window using 
the Track > New... menu item.

2. Create a stereo Instrument Track.

3. In the track’s inspector, click a blank 
insert and select multi-mono plug-in 
> Instrument > Liquid Music (mono)

4. In the same track, click a blank insert 
below the one containing Liquid 
Music, and select any instrument 
you have installed. For this example, 
we are using Chromaphone. 
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5. Assign the Instrument Track MIDI 
routing for the instrument that you are 
using, in this example Chromaphone. 
First, set the MIDI Output to Inst 
1 - ‘Chromaphone’ MIDI in 1.

6. Next, set the MIDI Input to Inst 1 - 
Liquid Music Out > All Channels. It 
is important to note that sometimes, 
you’ll need to try Liquid Music Out 2 
if Liquid Music Out is not working.

Note: Please make sure you don’t have any default settings that could cause a feedback loop. 
You could damage your ears, your speakers, spook your cat, your spouse, lots of things could go 
wrong. Basically, you want to avoid a scenario where the recipient track is also broadcasting MIDI 
and the Liquid Music track is set to receive MIDI from it. Please try to avoid this at all costs. 

7. Record-arm the track.

8. Enable Looping in Pro Tools. You can 
use the Options > Loop Playback 
menu item or its corresponding key 
command. This will let you work 
on 4 bars, for example, without 
needing to stop and restart.

9. Adjust the loop size and location.

10. Press Play in Pro Tools and switch to Liquid Music. Now, the notes 
you draw will start playing through the recipient track!
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4.6  Studio One 3

4.6.1  VST Mode

1. Launch Studio One 3 and create a project.

2. Click the Instruments tab in the Browser.

3. Drag-and-drop the Liquid 
Music VST from VST3 > Synth > 
LiquidMusic onto the arranger 
to create an instrument track 
containing Liquid Music. 
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4. Following the same procedure, 
load any software instrument 
or sampler. In this example, 
we’re using Chromaphone. 

5. With the Chromaphone track 
selected, click the i icon to 
reveal the track Inspector.

6. In the track containing the recipient instrument, set the Input 
channel–indicated by In–to Liquid Music.

7. Now, when you draw something in Liquid Music, you’ll hear 
the results coming through your second plug-in. 
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Multiple Plug-In Instances for Liquid Music

1. You can have multiple instances of Liquid Music. What does this look like? 
Rather than have multiple Liquid Music application windows open, you will have 
only one application window. To clarify, this is the application window:

2. To switch between the multiple instances, click the EDITOR button on the plug-in 
window to focus on that particular instance. To clarify, these are plug-in windows:

3. In the above example, there are three instances of Liquid Music loaded. 
All three of these plug-in use the same application window. To switch 
between which plug-in you are editing, click the EDITOR button.
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Chapter 5

User Interface Elements
Use this chapter as a guide to finding the various UI elements found in Liquid Music. 

5.1  Toolbar

The toolbar contains transport tools, loop controls, buttons to show and hide panels, along 
with a couple buttons that make navigating through Liquid Music quicker and easier. 

5.1.1  Clip Controls

Use the Clip Controls to launch or stop an Ableton Clip. The display windows shows 
the location of the playhead (that red line that moves during playback).
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5.1.2  Follow Playhead

Click the Follow Playhead button to scroll the contents of the Arranger as the clip plays back. 

5.1.3  Loop Controls

The two displays indicate the start point and length of the loop region, respectively. 

* Click the Loop Toggle button to activate the loop region. The two 
displays to the left show the start point and length of the loop region. 
You can click inside either window to manually enter a value. 

* Click the Automatically Loop Selection button to snap the loop 
region to the selected region(s) in the Arranger.

5.1.4  Refresh from Live

Click the Refresh from Live button to grab any MIDI contents you 
might have added to the clip using Live’s MIDI editor. 
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5.1.5  Edit MIDI Map

Click the Edit MIDI Map button to reveal all mappable parameters in Liquid Music. 
Simply click any red-bordered UI element and more a knob or fader on your 
physical MIDI control surface (see page 28) to assign that control. 

Note that you can also toggle Edit MIDI Map mode using the following commands:

* In the menu, Options > MIDI Mapping Mode > Edit MIDI Map
* Using the keyboard shortcut: [command]/[ctrl]+[M] 

5.1.6  Panel Show / Hide Buttons

Use the buttons along the right of the toolbar to show or hide panels in Liquid 
Music and Liquid Rhythm. Note that you cannot hide the Arranger panel. 
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5.2  Harmony Builder

The Harmony Builder is the panel that runs along the left of the screen. It contains the following tabs:

1. Presets (see page 53)
2. Sketch (see page 58)
3. Chords (see page 62)
4. Voice (see page 77) 
5. Rhythm (see page 92)
6. Key (see page 107)
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5.2  Arranger

The Arranger is the canvas you paint your sketches on. It also 
contains a wealth of features and information.
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5.2.1  Arranger Canvas

The Arranger Canvas is where you sketch your melodies. 

* Dark Grey horizontal blocks show you the root of the chord in the track above
* Light grey horizontal blocks show you the rest of the chord tones
* Dark vertical lines divide each measure
* Light vertical lines indicate quarter note division.

5.2.2  Contour Edit

Use the buttons in the Contour Edit panel to change how the sketches you draw are visualized, to 
move the sketch up or down by an octave, or to switch between marquee selecting and painting. 
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5.2.3  Piano Roll

The piano roll on the left of the Arranger helps label the blocks of MIDI in the Arranger. 

5.2.4  Rhythm Edit

The Rhythm Edit panel contains tools to edit the contents of the Rhythm track. 

* Grid resolution
* Paint mode
* Note edit mode
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5.2.5  Rhythm Track (see also page 93)

The Rhythm Track contains the rhythmic progression for the notes in the arranger 
above. To edit the rhythms of the notes in the arranger, you make changes here.

5.2.6  Chord Track (see also page 64)

The Chord Track contains the chords you sequence using the Chords tab in the Harmony Builder. 
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Chapter 6

Master Presets
Presets are a great way to get acquainted with Liquid Music. Just load one, draw 
a melody and press play! You might get inspired to write something new, discover 
something about the software you didn’t know before, or have hours of enjoyment 
mixing up all the presets using the Scramble! (see page 55) feature. 

6.1  Load a Preset

Click any item in the Master Presets list to load the skeleton (see 
page xx) of a track. This includes the following layers:

* Sketch (see page 58)
* Chord progression (see page 62)
* Voicing settings (see page 77)
* Rhythm (see page 92)
* Key (see page 107) 
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6.2  Randomize Presets

Click the Show Layer Matrix button to bring five columns of magic buttons into 
view and add an element of exploration and surprise to the Master Presets. By 
default, the Layer Matrix should be in view; click this button to toggle it.  

6.2.1  Mixing-and-Matching

Each column of buttons in the Layer Matrix represents one layer of a preset. Click buttons 
in different rows to mix-and-match various musical elements of presets with each other. 
For example, mix the chord progression of preset A with the rhythm from preset B:
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6.2.2  Scramble!

Click the Scramble! button to randomly select matrix buttons. This essentially 
mixes different qualities of different presets to each other. 

6.2.3  Options

Click the Options button to reveal a menu with more customizing features.
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6.3  Preset Filters

The preset list contains hundreds of entries. Narrow down the results shown using the Preset Filters 
below. Each preset has been tagged appropriately to help you navigate this list with ease. 

For example, if you choose the following: 

* Arpeggiated (see page xx)
* Bluesy
* 4-bars long

The results will narrow down to suit this search:
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6.4  Transpose

When you load a preset in Liquid Music for Live, we have no way of telling which synthesizer or software 
instrument you have paired with it. As such, the presets you load might not match the range of your 
synthesizer. When this is the case, you can transpose (see page xx) the notes in the arranger. 

* Click the Key and Mode dropdown menus to change either. 
* Click the Transpose Contour up and down arrows to shift the 

sketch in the Arranger up or down by an octave. 
* Deselect By Octave to nudge the sketch by smaller–scalar (see scale, page xx)–increments.
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Chapter 7

Sketch 
The ability to sketch a melody is one of the cornerstones of Liquid Music. We’ve put 
a great deal of care into its design: It’s simple enough that anybody–regardless their 
knowledge of music–can sketch a melody, while allowing experienced users and / or 
musicians to interact with a familiar surface in a new, intuitive, and exhilerating way.

7.1  How to Draw Notes

7.1.1  Fundamental Concepts

Click-and-drag across the surface of the Arranger and notes appear around what you draw. But a 
number of factors influence the placement of those notes. Use the image below as a reference:

1. Sketch: Notes appear around what you draw.
2. Rhythm (see page 92): Notes only appear along the rhythm points in the pattern below.
3. Voice Control (see page 78): How many simultaneous notes will appear? A yellow 

power button indicates that a voice is active. If you want to stack more notes on 
top of each other, just activate another voice using its adjacent power button.

4. Chord Track (see page 64): The notes in the Arranger always obey the 
guidelines (those grey lines) set by the chords in the track above. If you want 
to change the guidelines, change the chords in the track above.    

q

w

e

r
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7.1.2  Interacting with your Sketch

Once a Sketch has been drawn, it’s an object you can interact with. 

* Click-and-drag your Sketch up or down to transpose (see page xx) it. 

7.2  Layer Presets

Click the dropdown menu in the Sketch Layer Presets panel to choose from a well-defined 
list of preset sketches and patterns. Use these to get a sketch onto the Arranger quickly.

* Drop-down Menu: Reveal this menu and select an item to load it.
* Arrows: Scroll through the items in the preset list. 
* Scarmble!: Randomly choose a sketch.
* Save: Store the sketch currently in the Arranger window. A 

window will pop up allowing you to name the sketch. 
* Reset: Restore the entire panel to default settings. 
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7.3  Settings

Sometimes you might love the shape of your melody sketch but it’s in the wrong range. 
For example, perhaps the resulting sound is too shrill and high-pitched, or too bassy and 
barely audible. When this is the issue, there is a good chance all you need to do to fix the 
problem is nudge the sketch you drew up or down by an octave (page 112) or two. 

* Transpose Contour: Use these arrow buttons to transpose(or 
move) the sketch up or down an octave. 

* By Octave: Uncheck this box to nudge the sketch by smaller scalar increments. 
Doing this can change the melody that results, so be warned!
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7.4  Sketching Tips

Some cool things to help you along the way: 

* Press-and-hold the [option]/[alt] key while sketching to draw a straight line

* Press-and-hold the [shift] key to toggle marquee select. 
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Chapter 8

Chords
In Liquid Music, you can sequence chord progressions the same way you sequence rhythms, 
filter cuts, or envelopes in traditional synthesizers. We’ve created a lot of useful tools to help 
you build sweet and colourful progressions if you have no experience with chords, while 
satisfying anyone with thousands of hours of experience with a robust set of features. 

8.1  Preface 

Learning music theory is a very rewarding endeavour. As you dive into music and chord 
theory, you will undoubtedly find many rich resources online. We encourage you to embrace 
these different approaches as they offer their own set of valuable perspectives. 

Some personal favourites include:

* http://www.musictheory.net/
* http://tobyrush.com/theorypages/index.html

The study of music theory will make you a better musician. That said–as a formally educated 
musician–let me emphasize the following: Always follow your ears above all rules and guides. 
Chances are, if something sounds great to you, it’s going to sound great to someone else. It would 
be a shame to scrap an original idea because it doesn’t follow the rules of traditional theory.

In Liquid Music, we’ve put a great deal of work into automating the rules of harmony 
for you. You can follow these rules and come to some awesome results, but they are 
far from being the only results you can get. Which is why we have also given you the 
freedom to roam outside the world of harmony that is “music theory approved”. 

Music theory explains the music that has been, but not the music 
that will be. So learn the rules, but please break them.  
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8.2  Chords Layer Presets

Use the Chords Layer Presets to quickly load an entire chord progression (see 
page 110). All the chords are listed as Roman Numerals (see page 90).

* Arrows: Scroll through the items in the preset list. 
* Shuffle: Randomly selects a chord progression from the preset list. 
* Save: Stores the current settings in the entire Chords panel. A 

new window will appear allowing you to title the preset.
* Reset: Restores the entire Chords panel to default.  

http://en.wikipedia.org/wiki/Roman_numeral_analysis 
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8.3  Chord Overview

The Chord Overview panel lets you adjust the length and positioning of the chords in the 
arranger. This is perfect for adding some variety to how often and when your chords change.

8.3.1  Chord Track

The edits you make to the lengths and positions of chords is directly reflected in the Chord Track. 
Every chord progression you create with the Chords panel directly informs the contents of the 
Chord Track above the Arranger. The Chord Track determines which notes can be drawn into 
the Arranger below. Think of it as a filter that only allows the notes of the chord through in. 

There are a number of ways you can interact with the Chord Track directly: 

1. Click a chord to select it. 
2. Click the edge(s) of a chord and drag left or right to resize it. 
3. Right-click on a chord to reveal a drop-down menu; use it to resize, copy, or change the chord. 
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8.3.2  Add a chord

There are two ways to add a chord using the Chord Overview panel.

4. Click any blank chord slot to add a chord.

i. The Chord Overview displays four chords at a time by default. If all four 
chord slots are active and there is no blank chord slot in view, scroll the 
Chord Navigator to the right until you find a blank chord slot.

5. Click the Add Chord button. If there is no selection in the Chord Overview, pressing 
this button adds a chord to the end of the chord progression (see page 110). 
The added chord will be the same as the chord immediately to the left of it.

i. If there is a selection in the Chord Overview, pressing Add Chord inserts a chord directly 
to the right of the selection. The type of chord will be the same as the selection. 
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8.3.3  Select a chord

Click a chord to select it. This is useful in applying resize transformations. 

To deselect a chord:

* Press-and-hold [command]/[ctrl] and click the chord. 
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8.3.4  Resize Chords

There are a number of ways to resize chords.

1. Click the length beneath any chord to resize it.

2. Use the options in the Resize Chords section. You can either:
i. Increase or decrease the size of chord(s) by an1/8th of a bar (see page 110).
ii. Double or halve the length of the chord(s).
iii. Note that these resize transformations apply to every 

chord unless you have made a selection.

8.3.5  Loop Chords

Click the Loop Chords button to activate the loop region exclusively around the chords that appear in 
the Chord Overview panel. This is useful when you’re building and / or tweaking a section of your track.
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8.3.6  Chord Overview Options

Click the options button in the Chord Overview panel for more controls and customizability.
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8.4  Suggester

The Suggester helps you pick the next chord in your progression. It lays out a path for you to follow 
when playing with chords. It’s perfect for creating chord progressions quickly or experimenting with 
stuff you might never have made otherwise. For more on how the suggester works, see page 113.
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8.4.1  How to use the Suggester

There are two steps to building a chord progression using the Suggester. 

1. Choose a mood from the drop-down list.

2. Click a chord in the first column to populate the second colum with chords. Each 
chord you select influences the chords in the adjacent column to the right. 
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8.4.2  Scramble the Suggester

To add an element of excitement and chance, we’ve added a couple scramble features to the Suggester. 

1. Click the Scramble button to get a random selection in each column. 

2. Right-click a chord and select Scramble from Next Column to get a 
random result in the adjacent column to the right and onward. 
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8.5  Sequencer

Use the Chord Sequencer to create exactly the chord progression you’re looking for. 
This panel gives you total control of the chords while allowing you to build chords one 
part at at time. It’s perfect for programming a progression you already have in your head 
or if you want to edit something you got using the Suggester or Chord Presets. 
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8.5.1  Chord Roots

Every chord has a special note from which the rest of the chord stems. This note is called the Root. 
Superficially, it’s the first character in the chord’s name. For example, the root of the chord “Em7b5” is “E”. 

In the Chord Sequencer, the first part of the chord you select is the root. 

* Click a cell in the Chord Roots sequencer to select it. 

8.5.2  Out-of-Key Root Notes

By default, only notes that are in the chosen key appear in the Roots list. Click the 
Show Out-of-Key Roots checkbox to show all twelve chromatic tones in the Roots 
sequencer. Notice that out-of-key (see page 112) notes are coloured light blue.
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8.5.3  Chord Types

The second part of the sequencer is the Chord Type sequencer. For our purposes, we can also refer 
to these as Triad Types. Triad types define the quality of the chord: Will it be major, will it be minor, 
etc? In Liquid Music, we break down Triad types (or Chord Types) into the following categories:

1. Major triads
2. Minor triads
3. Diminished triads
4. Augmented triads
5. Suspended chords
6. Scales

By default, the Chord Type that is in key will be selected. Click any chord type 
to select it. Note that out-of-key Chord Types appear in light blue.

For more on triad types, see page 114.
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8.5.4  Out-of-Key Chord Types

By default, the Chord Type sequencer displays out of key chord types. This is helpful 
in guiding you to all the chords that are in key. That said, it also sounds pretty cool to 
pick the same chord type for all your chords, so be sure to try out this feature!

Click the Show Out-of-Key Types and Modifiers (see page 112) checkbox to toggle this on and off.
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8.5.5  Chord Modifiers

After you have built a chord using the Root and Type sequencers, you can begin to add 
intersting tensions and colors to those chords using the Chord Modifiers (see page 110) 
sequencer. This is a great way to add more notes to the chords you’re using. 

As with the Root and Type sequeners, Modifiers that are in key are colored dark blue. 

Click a cell to add it to your chord. Note that you can only add one cell per column.
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Chapter 9

Voices
The Voices tab might have a cool and enigmatic name, but it’s actually useful for a variety of highly 
common things in Liquid Music! Some examples of things you can do with the Voices panel:

1. Set the number of simultaneous notes in a chord. 
2. Set the size and style for the Arpeggiator. 
3. Filter notes out of the arranger based on their rhythmic location.
4. Add chord stabs to an arpeggiation pattern .

The following sections will discuss each panel in the Voices tab in greater detail. 

9.1  Voice Layer Presets

Use the Voice Layer Presets to quickly load settings into the entire Voice tab.

* Drop-down menu: Contains presets; click to load them.
* Arrows: Cycle through the presets in the list. 
* Scramble: Randomly select a preset from the Layer Preset list. 
* Save: Save the current settings in the Voice tab as a Layer Preset; a window 

will appear prompting your to title your preset before saving it. 
* Reset: Restore the entire tab to default values. 
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9.2  Voice Control

Use the settings in the Voice Control panel to add or remove a voice from 
the Arranger, change the behaviour of a voice when you sketch a melody, or 
apply a random possibility that a voice will play in the first place.  

9.2.1  Presets

The Voice Control panel has its own set of presets useful for hot-swapping 
voicing settings while maintaining an arpeggiation or filter pattern. The 
controls are identical to those found in the Voice Layer Presets: 
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9.2.2  Voice

When you sketch a melody, how many simultaneous (or harmonic) notes appear in the Arranger 
is determined using the Voice buttons in the Voice Control panel. The central voice, denoted 
simply by a “–”, is the voice that most closely follows what you draw. Think of the other voices 
as occurring either above or below the central voice (hence the +/- in the naming scheme).

* Click a power button to activate a voice.

9.2.3  Nudge Voices

You can move the central voice to allow more notes above or below it by 
clicking the nudge voices button. In the example below, the central voice has 
been nudged all the way to the top to allow 8 voices beneath it:
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9.2.4  Motion

When you have multiple voices activated, you can get some pretty sweet musical results by changing 
the motion of one or more voice(s). For example, you can have one voice move the opposite direction 
when you sketch, or have a voice play the same note while other voices move around it. The options are:

1. Similar: The voice moves in sync with your sketch.
2. Contrary: The voice moves the opposite direction of your sketch, 

for example you draw up, contrary goes down.
3. Oblique: The voice moves in a straight line regardless of how you sketch. Note 

that oblique voices always play a note in the chord in the track above. 
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9.2.5  Frequency / Offset / Pattern Reset

The Frequency knob sets how often a voice registers a note on the arranger. For example:

Notice how the highlighted notes occur on every 2nd note with the Frequency knob on 2. 

* Click a Frequency knob and drag up or down to change its value. 

The Offset knob becomes active when you increase the frequency value. It moves 
the starting point of the associated voice. Experiment with both the Frequency and 
Offset knobs to get interesting and staggered textures. For example:

 

Notice how the highlighted notes have shifted over by 1 note. 

* Click an Offset knob and drag up or down to change its value. 

The Pattern Reset knob restarts the Frequency count for the knobs above. Once 
you have some settings dialed into the Frequency and Offset knobs, change 
the Pattern Reset to see what kind of variations you can create. 
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9.2.6  Probability

These knobs reduce the probability of a note occurring in a corresponding voice. 
Use them to thin out the arrangement in a random / methodical hybrid workflow: 
You choose the voice to thin out, Liquid Music randomly removes notes. 

* Click-and-drag a knob up or down to change its value. 
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9.2.7  Re-Apply Settings

Any parameters with a random element–like the Probability knobs–can be re-
applied to the notes in the Arranger using the Re-Apply button. 

9.2.8  Scramble!

Click the Scramble! button to randomize the entire Voice Control panel. It’s a great 
way to jump between disparate settings and see what the panel can do.
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9.2.9  Voice Control Options

Click the options button to reveal a menu with some more controls:

9.2.10  Voice Filter and Arpeggiator Active Indicators

Activating the Arpeggiator or Voice Filters overrides certain controls in the 
Voice Control panel and effects the placement of notes in the Arranger. For this 
reason, there are indicators at the bottom of the Voice Control panel.
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9.3  Arpeggiator

The Arpeggiator takes all the notes in a chord and plays them back to you melodically–
meaning one note at a time. This is a great for creating melodies based solely on the 
notes in a chord, or for creating textured accompaniment using a synthesizer. 

9.3.1  Turn on the Arpeggiator

Click the power button to activate the Arpeggiator. 
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9.3.2  Arpeggiator Styles

There are a number of patterns built into the Arpeggiator. 

* Click the drop-down menu to access the full list; we recommend you test them all!
* Click the arrow buttons to cycle through the items in the dropdown menu. 

9.3.3  Reset the Arpeggiator

Press the Reset button to restore the Arpeggiator settings to default. 

9.3.4  Offset / Pattern Reset

* Change the Offset value to begin the Arpeggiator pattern from a different spot in the pattern
* Use the Pattern Reset knob to restart the Arpeggiator pattern after a specified length.
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9.3.5  Re-Apply

Some of the patterns in the Arpeggiator Style list contain a random element. 
Click the Re-Apply button to get a new result for those patterns. 

Note that the Re-Apply button is greyed-out if there is no random 
element to the arpeggiator pattern selected. 

9.3.6  Scramble!

Click the Scramble! button to randomize the entire Arpeggiator panel. Roll the dice, ya know? Live a little. 
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9.3.7  Arpeggiator Options

Click the Options button in the Arpeggiator panel to check out some fine tuning features. Personal 
favorites include deeper controls for the pattern reset behaviour. It’s cool; you should check it out! 
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9.4  Voice Filter

There are two ways the Voice Filter works:

1. The Voice Filter reduces the amount of simultaneous voices that can occur 
in the arranger. If something you’re working on is feeling very dense, you 
can use the Voice Filter to intelligently thin out the overall sound. 

2. When paired with the Arpeggiatory, the Voice Filter behaves differently: It becomes additive 
in that it adds notes to arpeggiator patterns to create chord stabs and syncopated effecsts. 

Both modes will be discussed in this section. 

* Click the Power button to activate the Voice Filter

9.4.1  Voice Filter Presets

Use the Voice FIlter Presets to get going quickly. 

* Drop-down menu: Contains presets; click to load one. 
* Arrows: Cycle through the presets in the list. 
* Scramble: Randomly select a preset in the list. 
* Save: Store the current settings in the Voice Filter as a new preset; a 

new window will appear where you can name your preset. 
* Reset: Restore the Voice Filter panel to its default settings. 
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9.4.2  Polyphony Buttons

(With the Arpeggiator turned off) 

The Polyphony buttons determine which notes will stay when you reduce a fader. 

For example, if a button is set to “Upper”, the uppermost note(s) in a stack of notes will remain when 
you reduce the fader’s value. If a button is set to “Lower”, the lowermost note(s) will remain. 

(With the Arpeggiator active)

The Polyphony buttons dictate where the added notes will appear. “Upper” indicates that notes 
will appear above the arpeggiator pattern, “Lower” indicates that notes will appear below the 
arpeggiator pattern. This is a great way to create syncopated chord shots in an arpeggiator pattern. 
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9.4.3  Polyphony Sliders

Click and drag the Polyphony Sliders (see page 112) to either subtract or add notes to the arranger 
based on their rhythmic locations. See page 89 to review the difference between the two modes. 

* Click-and-drag a slider to change its value.
* Click-and-drag the handles on the outside of a slider to expand it. An expanded 

slider creates a range of values, any of which will be randomly selected.

9.4.4  Voice Filter Re-Apply

When you have expanded sliders (as in the image above), click the Re-
Apply button to select a new value within each expanded region. 
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Chapter 10

Rhythm
There is no better way to get a new feel for something you’re working on than switching up 
the rhythm pattern (see page 113). Liquid Music gives you that ability to the highest degree. 
Keep your chord progression and melody shape static while you cycle through various rhythm 
patterns. You can also use certain modules in this tab to add some articulation (see page 110)
effects. Use the presets we’ve created, or use our editing tools to create something new. 

10.1  Rhythm Layer Presets

Click the Rhythm Layer Preset drop-down menu and select a preset to load a new rhythm pattern, 
change note durations, and switch up velocity and groove settings is to load a Rhythm Layer Preset. 

* Drop-down menu: Contains presets; click to load one. 
* Arrows: Click these two buttons to cycle through the presets in the adjacent drop-down menu.
* Scramble: Randomly selects a preset from the list.
* Save: Saves the settings in the entire Rhythm tab as a new preset; a new 

window will appear allowing you to title the preset appropriately. 
* Reset: Restores the entire Rhythm tab to its default settings. 
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10.1.1  Rhythms in Liquid Music

The rhythm patterns you load using the Rhythm Layer Presets appear in the Rhythm Track that runs 
along the bottom of the arranger. By separating the melodic and rhythm elements of music into 
two distinct panels, you have a new dimension of creativity to explore. So enjoy, and be safe. 

10.1.2  Rhythm Edit

You can manually edit and create rhythms using Liquid Music Rhythm 
Edit tools. Just draw directly onto the rhythm track. 

* Click the Inline Edit Mode button to activate editing. 
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10.2		 Duration	Modifiers

The Duration Modifiers make macro-level adjustments to note lengths in the arranger. They work by 
targeting notes occurring in a particular rhythm location. Note that the Duration Modifiers are always on. 

10.2.1  Presets

As with all the panel in Liquid Music, the Duration Modifiers features 
a list of presets you can load to get going quickly. 

The controls are identical to those in the Rhythm Layer Presets:

* Drop-down menu: Contains presets; click to load one. 
* Arrows: Click these two buttons to cycle through the presets in the adjacent drop-down menu.
* Scramble: Randomly selects a preset from the list.
* Save: Saves the settings in the Duration Modifiers panel as a new preset; a 

new window will appear allowing you to title the preset appropriately. 
* Reset: Restores the Duration Modifiers panel to its default settings. 
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10.2.2  Duration Modifier Buttons

Use the Duration Modifier Buttons to set the length for a note 
occuring on a corresponding rhythmic location. 

* Single-click a button to cycle lengths.
* Click-and-hold any button to reveal a drop-down menu with note lengths.
* The All button–the rightmost button–applies a note value to every slider in the panel.

Hovering the cursor over a button (or slider for that matter) highlights the targeted notes in the arranger:
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10.2.3  Duration Modifiers Sliders

Use the Duration Modifiers Sliders to reduce the length of notes based on a percentage 
value. For example, if you use the buttons above to set the note length to 1/2 notes, 
you can reduce the length of those by reducing the value of the slider. 

You can also grab the handles on the outer portion of each slider to expand 
the slider. This adds a degree of variability to the results generated. 

10.2.4  Re-Apply

Click the Re-Apply button to get new duration results based within the expanded regions in the sliders.
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10.2.5  Duration Scramble!

Click the Scramble! button to randomize all the controls in the Duration Modifiers panel. 

10.2.6  Duration Options

The Durations Options menu contains lots of customizing features. For example, change the slider 
scheme from eight individual sliders to three colour-coded sliders for greater macro control. 
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10.3		 Velocity	Modifiers

The Velocity Modifiers (see page 114) give you large-scale control over the volume / dynamics (see 
page 111) of the notes in the Arranger. The synthesizers you might be controlling with Liquid Music 
will likely respond well to varying dynamics: You might hear different sounds coming out of the same 
patch depending on whether the incoming note has a high velocity vs a low velocity. As such, this effect 
is great for creating a humanized and textured feel. Note that the Velocity Modifiers are always on. 

Note that all the velocity values are displayed on the rhythm track that runs along the bottom 
of the arranger. They are the rectangular bars above the diamond-shaped notes:
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10.3.1  Velocity Modifiers Presets

Choose from a variety of velocity effect presets. Keep in mind that–as with all the transformation 
controls in Liquid Music–the Velocity Modifiers effect notes based on their location within a 4/4 bar. 

The controls are identical to all preset controls. 

10.3.2  Velocity Modifier Buttons

The Velocity Modifier Buttons allow you to shape the velocity values created within an 
expanded slider. Paired with the “Random” shape, for example, this is a great way to 
create humanized (see page 111) velocity. There are three possible values:

1. Random 
2. Upward
3. Downward

Click any button to cycle through the shapes. Click-and-hold a button to reveal a dropdown menu.
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Use the buttons to create some familiar wave shapes like triangles, 
sawtooths, and reverse sawtooths. Here’s a triangle, for example:

 

10.3.3  Velocity Modifier Sliders

Click-and-drag a slider up or down to change its value. Click either of the 
outer handles on a slider and drag up or down to resize the slider. 
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10.3.4  Velocity Modifiers Re-Apply

Click the Re-Apply button to generate a new value within any expanded sliders’ range. Note 
that a Velocity Modifier’s Shaper Button needs to be set to Random to use this feature. 

10.3.5  Velocity Modifiers Scramble!

Click the Scramble! button to randomize the entire Velocity Modifiers panel. 
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10.3.6  Velocity Modifiers Options

Click the Options menu button to reveal the Options menu. You can change the slider scheme, 
apply different color-coded patterns to the rhythms you’re working with and so on. 
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10.4		 Groove	Modifiers

Use the Groove Modifiers (see page 111) to apply swing, stutter, anticipation, and glitch effects 
to the timing of the notes in the arranger. Note that the Groove Modifiers are always on. 
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10.4.1  Groove Presets

Just because it’s electronic music doesn’t mean it needs to sound robotic. Load a Groove preset 
to hear what your quantized (see page 112) and rigid idea sounds like with a bit of altered feel. 

* Click a preset in the drop-down menu to load it. 

All the navigation and panel controls are identical to the ones found in the layer presets.
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10.4.2  Groove Modifier Sliders

The Groove Sliders are the main attraction of this here panel. Move them 
around, see how the notes in the arranger move around!

* Click-and-drag the sliders up or down to change their value. 
* Click-and-drag the handles on the outside of a slider to expand it.
* The default groove position is in the center.  

10.4.3  Groove Modifiers Re-Apply

Click the Re-Apply button to generate a new value within any expanded sliders’ range. 
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10.4.4  Groove Modifiers Scramble!

Click the Scramble! button to randomize the entire Groove Modifiers panel. 

10.4.5  Groove Modifiers Options

Click the Options menu button to reveal the Options menu. You can change the slider scheme, 
apply different color-coded patterns to the rhythms you’re working with and so on. 
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Chapter 11

Key
The Key is like the language your track is in. Whether a track feels cheerful 
or dark or mysterious is–in part–dependent on the key and mode. 

The sound of your track can change dramatically when you swtich up the key:

* If you sing, you might notice it harder or easier to sing in a new key. 
* If you play guitar or bass, you might find some keys much 

more comfortable to play than others.
* If you are using a software synthesizer, certain keys might 

complement the sound of that synth more than others.

The more you play around with the Key element of your track, the quicker you’ll 
start to figure out your own comfortable range for things. The key(s) you feel best 
singing in, the keys that make your synth sound extra nice, and so on. 

11.1  Key Layer Presets

The Key Layer Presets feature a list of tonal centers (page 113) matched with modes. 

For more on what a mode is, see page 111.

* Dropdown menu: Click a preset to load it.
* Arrows: Cycle through the items in the preset list. 
* Scramble: Randomly selects an item in the preset list. 
* Save: Stores the current settings in the Key tab as a preset; a new window 

will appear allowing you to appropriately name the preset.
* Reset: Restore the entire Key tab to its default settings. 
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11.2  Key Selector

The Key Selector lets you choose the Key and Mode of your current arrangement. 

11.2.1  Key

When you change the key letter only, the music will flow the way it did but in another range. This might 
make things feel different. For example, if the new key letter sends your melody up or down, the resulting 
sound will be pitched higher or way lower. Have you ever pitch shifted your own voice? If you have, 
you know that even 4 or 5 semitones has a dramatic effect. Changing keys is a largely experimental 
process–unless you can hear the change in your head–so play around and press undo when in doubt =)

* Click the Key drop-down menu and select a new key. 

11.2.2  Mode

When you change the mode, the music will not flow the way it once did. You might make a major 
melody go minor, which will result in a change of mood. Different chord types and modifiers will 
become available in the chord sequencer. You might choose some obscure mode that is so far from 
what you originally had that you’re unsure how the new result could possibly be related to the original. 
But it’s all good! Somewhere in the world, this crazy sound you’ve found will have its share of fans. 

* Click the Mode drop-down menu and select a new mode. 
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11.2.3  Dual  

One of our bright young programmers wrote an algorithm for determining the mirrored 
equivalent of a Mode we call “Dual Mode”. This only works with the first 7 modes on 
the list, but the results are amazinglyt cool, so make sure to check it out.

* Click the Dual button to apply the transformation. 

11.2.4  Key Options

We’ve placed a variety of useful stuff in the Options menu. Everything from displaying a 
simplified Mode list to common transpositions you might want to apply are here: 

* Click the Options button to reveal the menu. 
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Glossary

Accidentals
Refers to raised notes (sharps) and lowered notes (flats) who are not a member of the scale. 

Arpeggiator / Arpeggio
An arpeggio is a type of staggered–or broken–chord that rises and falls in a given fashion. If you 
have a sibling or friend who practices the piano, you’ve definitely heard these being played. 

An arpeggiator is a type of MIDI effect that generates an arpeggio pattern.

Articulation
A musical performance technique that affects how a note is attacked, 
sustained, and how a note transitions to another note. 

Bar / Measure
A bar of music is a segment of time comprised of a specified number of beats. In Liquid Music, all bars 
are a whole note in length. This is the same as two half notes, four quarters, eight eighthts, and so on.. 

Chord
A chord is any set of three or more pitches played harmonically (that is, at the same time). Actually, the 
notes don’t need to be played simultaneously and many people would consider two-note pairings–like 
power chords and dyads–totally acceptable as chords. The most basic form of a chord is a triad.

Chord Degree
Unlike a chord tone, a chord degree is a (somewhat) colloqiual term used to identify any 
note in a modern chord. For example, the 7th chord degree in Cmaj7 is B (C-E-G-B).

Chord Modifiers
In Liquid Music, a chord modifier is any note added to a chord that isn’t part of the 
fundamental triad. So, anything beyond the Root, 3rd, and 5th of the chord. 

Chord Progression
Two or more chords played in sequence. Chord progressions are typically 
repeated and often mark a specific section within a song. 

Chord Tone
A chord tone is a pitch that is part of a functional chord; that is 
to say, the note is either the root, 3rd or 5th. 
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Chromatic Scale
A scale with twelve pitches each separated by a semitone; all the notes are equally distributed within an 
octave typical of Western music. Other parts of the world divide the octave with more or less pitches. 

Chromatic Transpose
To shift a collection of notes by a fixed number of semitones. 

Diatonic Scale
A scale with seven notes. Diatonic scales account for the majority of scales used in Western music. 

Dynamics
Refers to the volume of a note.  

Groove
The sense of rhythm feel in a track that makes you want to move. It’s kinda hard to 
pin this down, but when you hear something with groove, you generally just ‘feel’ it. 
In Liquid Music, groove refers to the rhythmically offset quality of a note.  

Humanize
The act of applying a certain degree of variance to the velocity, duration, and positioning 
of a note or group of notes in order to achieve a more life-like performance.

Instrumentation
The combination of instruments used in a song / track and the qualities of each 
individual instrument. This is often synonymously referred to as Orchestration.

Interval
In music, the term interval is used in reference to the distance between two 
notes. For example, the interval from C to E is that of a major 3rd. 

Key
The key of a song is the note–commonly referred to as the tonic–that 
gives a sense of home and arrival in a given piece of music. 

Modes
In Liquid Music, you will find four distinct scalar languages. They are: 

1. Natural 
2. Jazz Minor
3. Harmonic Minor
4. Harmonic Major
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Each of these scales has seven modes–or scales–built using the framework each lays down. 
In total, there are 28 modes. Some of them are familiar (like the major or minor scale), some 
of them extremely exotic (like the seventh mode of Jazz Minor). Use the various modes to 
create intersting moods and textures for the tracks you produce using Liquid Music. 

Monophony
A single line of melody. When used in synth-speak, this typically 
means that you can’t play more than one note at a time. 

Octave 
The distance between a note and itself in a higher or lower range. 
1 octave = 12 semitones (see page 113). 

Out-of-Key
Depending on the key you are in, you will have a certain number of notes “in key”. If you chose the Major 
scale, for example, there are seven notes “in key” (given a tonic [see page 113]). The other five notes 
(the rest of the notes of the chromatic scale) would be considered out-of-key for that song. Of course, 
this doesnt’ mean you should stay away from out-of-key notes; that’s why we let you use them all! 

Certain triad types will be out-of-key depending on the key and mode you are using. This is because 
of how triads are built (see page 114). Basically put, the intervals between the notes in a given 
scale dictate the “in-key” triad type that will stem from a given note in that scale. For example, in 
the key of D harmonic minor, it just so happens that triad built on scale degree 1–that is, the note 
D–is a minor triad. This is because the other notes in the scale include F and A. If you measure 
the intervallic distances between these three chord tones, you end up with a minor triad.

Polyphony
Two or more simultaneous lines of melody. When used in synth-speak, 
this typically means that you can play multiple notes at a time. 

Quantize
When notes are snapped to a grid to remove any rhythmic irregularity. 

Roman Numerals
We use roman numerals in music to represent notes in a given key and scale. For 
example, in the key of G Major, Roman Numeral ‘I’ is G, ‘ii’ is A, ‘iii’ is B, etc. 

Basically, each roman numeral is a chord. Uppercase numerals are major chords, 
lowercase numerals are minor (and sometimes dimished, in our lists). 

Since there are seven notes in most Western scales, you will only see seven roman numerals.

In this approach, each roman numeral is a function that can receive a letter name and still 
work properly, given any key. In other words, the benefit here is that you can use these chord 
progressions to create melodies that feel the same no matter what key you switch to. 
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This is a good resource if you want to research them further: 

http://en.wikipedia.org/wiki/Roman_numeral_analysis

Rhythm pattern
A repetitious movement of regular or irregular beats / accents. 

Scale
A group of notes ordered by pitch or frequency. In Liquid Music, you’ll find 
various types: Pentatonic, diatonic, and chromatic scales. 

Scalar Transpose
To shift a collection of notes by a fixed interval (see page 111) relative to a scale.

Semitone
Typically, the smallest distance between two notes in Western music *many 
guitarists and singers incorporate quarter tones in their playing and singing*. A 
semitone is the distance betwee any two adjacent keys on a piano. 

Skeleton
Liquid Music lets you produce musical ideas in a modular (or one-at-a-time) way by separating music 
into five layers. In this way, you can make easy and non-destructive substitutions to specific elements 
of a performance. For example, you can insert a different rhythm pattern into something you’re working 
on without disrupting the chords or voicings. Or you can change the melody shape while maintaining 
the chord progressions. If you don’t like the changes you’ve made, you can always retrace your steps  

Suggester
The suggeter is a yellow brick road for laying down chord progressions. We transcribed hundreds 
of songs and noted common paths that chords took between each other. Since the songs we 
transcribed were streamed off mood-based sites, we used their mood labels to help democratically 
tag our own results. The end result is a vast network of charted paths between chords. 

Of course, there is plenty more to consider regarding what makes a song feel objectively 
“sad” or “happy” than simply the chords; this is where your imagination comes in to 
fill the gaps. Some other factors include tempo, instrumentation, articulation, 

Tonal Center
See “Tonic” on page 113.

Tonic
The first scale degree of a diatonic scale. It’s the note that (subjectively) feels like “home”. 

Triad

http://en.wikipedia.org/wiki/Roman_numeral_analysis
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A triad is the fundamental basis of a chord. All the notes are stacked in 3rds. The 
members of a triad are called (from bottom to top): The Root, the 3rd and the 5th.

Triad Types
There are four triad types:

1. Major
2. Minor
3. Diminished
4. Augmented

What makes one triad minor vs diminished, for example? First, a look at how triads are built:

1. All triads are stacked in thirds; meaning, the root is layed down, the 3rd 
chord degree (see page 110) is placed a third above the root, and the 
5th chord degree is placed a third above the 3rd chord degree.

2. The interval of a third (the aforementioned space between the root, 
3rd, and 5th) can have two qualities: major and minor.

i. A major third interval is four semitones (see page 113).
ii. A minor third interval is three semitones.

Depending on the quality of third between each chord tone in a triad, the result is one of four triad types:

1. Augmented: Two consecutive major third intervals.
i. For example, C to E is a major third. E to G# is a major 

third. So C augmented is spelled C-E-G#.
2. Major: A major third interval between the Root and 3rd, and 

a minor third interval between the 3rd and 5th.
i. For example, C to E is a major third. E to G is a minor third. So C major is spelled C-E-G.

3. Minor: A minor third interval between the Root and 3rd, and 
a major third interval between the 3rd and 5th.

i. For example, C to Eb is a minor third. Eb to G is a major 
third. So C minor is spelled C-Eb-G. 

4. Diminished: Two consecutive minor third intervals. 
i. For example, C to Eb is a minor third. Eb to Gb is a minor 

third. So C diminished is spelled C-Eb-Gb. 

The final point to consider is when each of these triad types occurs naturally and why. For a not-so-
easy example, let’s look at the C Harmonic Minor scale. It is spelled as: C - D - Eb - F - G - Ab - B. 

To build any triad, all that is needed is to pick a note, skip one to get the third, and skip 
another to get the fifth. So, if the note I picked was Eb, then this would be my triad: 

C - D - Eb - F - G - Ab - B. 

Since we can measure the distance between these notes, we can easily determine 
the triad type it would spell: Eb to G is a major third, and G to B is a major third. 
So an augmented triad occurs naturally in the harmonic minor scale. 

Velocity
The measure of how forcefully a MIDI note is played / programmed. 
The resulting is often a volume-related or timbral change.   
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